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Requirements 
 

1. ArcGIS Online Account – based on organization (could use floating license pool if 
organization has this) 

2. Install Pro on desktop 

Data 
 

Data used in this document originate through publicly available data layers found by using ArcGIS Online 
(more specifically, the City of Sacramento’s Open Data portion of ArcGIS Online) or from a 
Sacramento_Data folder that contains a file geodatabase of different kinds of publicly available data 
sets so that some of the different ArcGIS Pro functions can be illustrated (e.g. connecting to data folder 
vs an online web service via ArcGIS Online).  Users of this document can substitute their own data 
sources or request the data folder from the author. 

Overview of ArcGIS Pro 
 

Working with ArcPro requires the creating of a “project.”  Several templates exist to work with 
data, maps, etc.  When creating a “new” project, a map template is used, a project name is 
provided, and a folder to manage data, maps, connections, etc are created.  Once a “new” 
project is created, a user can browse and find the ArcPro project to continue working on it. 

ArcPro differs from ArcDesktop by allowing for multiple “map documents” (e.g. page sizes, map 
data frames) as well as common geoprocesses and editing and or web publishing/sharing 
methods). 

 

Start ArcPro 
 

Click on ArcPro from the Windows Start menu.  Alternately, type in ArcPro in the Search box 
and then select ArcPro. 

If prompted, sign in with an ArcGIS Online account (username and password).  Access will be 
granted by the organization that has a relationship with ESRI and has a staff to administer 
ArcGIS Online accounts. 

A user can sign on later, but a user account will be required to use the tools and access online 
data. 

 



  



Create a New “Map” Project 
 

1. Select the Map.aptx template 
2. Assign a unique project name 
3. Change the folder as needed 
4. Check the box for Create a new folder for this project 
5. Click OK. 

 

 

 

An empty base map is provided in the map viewer.  The ArcPro environment may look like the 
following. 

 



Load Data (Map Layers) from Public Web Map Services 

1. Click on the black triangle on the Add Data Tool. 
2. Click Data 

 

 

3. Click on Portal -- All Portals    
4. In the Search box, type in Sacramento Schools 
5. Make sure to click on the Show Details icon in the upper right of the Add Data dialog box.  The 

details of the data set need to be viewed so the user can validate the correct data set to add 
from the web. 



 

  

Show Details 



 

6. After clicking enter on the search box, click on the Schools layer.  Validate that the details pane 
shows the City of Sacramento as the owner of the data. 

 

 

7. Click OK. 

  



ArcPro should look similar to this.  The map automatically zooms to the geographic extent of the data 
layer. 

 

 

  



8.  Do the same steps to add the Council Districts.  Search for Sacramento Council Districts. 

 

 

 

 

  



After adding the council districts, the map should look like this. 

NOTE:  If the council districts don’t appear, use the scroll wheel on the mouse to scroll “up.”  This 
changes the zoom level (to make the map appear more “zoomed in” (closer)).  The council district 
boundaries and colors should appear. 

 

 

 

  



Change the Base Map 
 

Since ArcPro typically adds a “default” base map, the base map can change by clicking on the Base Map 
tool and choose a different base map (e.g. Streets). 

 

 

 

 



Interacting with ArcPro 

Since Pro uses the “ribbon” technology for “look and feel” in the user interface, there are not “toolbars” 
to add. 

 

Navigation is performed by using the scroll wheel (zoom in/out) and using the left mouse button to 
“pan” (slide the map in any direction at the same scale). 

The user can also use the Explore button in the Map Navigation ribbon. 

 

  

 

  



Geoprocessing and Analysis 
 

Pro also doesn’t have a “toolbox” like Desktop but has an Analysis ribbon that contains a 
number of common analysis tools.  In addition, Pro has some “common” (favorites) 
Geoprocessing tools that may appear on the right side of the interface.  Users can pick from this 
list or choose Toolboxes to see a full list and/or search for various geoprocessing analytical 
tools.  This list and organization is similar to the ArcToolbox found in Desktop. 

 

             

 

  



Create a Map Layout 
 

Since ArcPro is “project-based” where an ArcPro project can contain references to data, web 
services, and can publish and work with data on the web, in addition to making one or more 
different map layouts, the user must create a new map layout for printing or creating a PDF. 

To do this, a new map layout must be “inserted” using the Insert—New Layout ribbon option. 

 

 

 

  



A new layout is created with a blank “page.”  Map data needs to be added to the map. 

 

Change the Map Name 
 

On the Layout tab, double click or right click--Properties to change the map name.  Remember, several 
different kinds of maps can be created for a single set of data, so having unique names for a map may be 
a good idea. 

 

Once a map layout is created, the user can use the layout space to continue manipulating the map for 
production (printing, saving to PDF, etc). 

Layout Ribbon and Tools 
 

The primary layout options are found on the Layout Ribbon 

 

Navigate – use this to “pan” around the map.  The mouse scroll wheel is used to zoom in/out of the 
layout page. 



The small icons next to the Navigate button are to zoom to full layout page, zoom to the width of the 
page, or zoom to 1:1 to observe what a map looks like if it was to be printed. 

Select – this tool is use to “select” map elements (map frame, graphics, text, legend, scale bar, etc). 

Orientation – change page orientation (portrait, landscape) 

Activate – this tool is used to “activate” the map frame so the map itself can be adjusted (pan, zoom, 
etc).  This is similar to using the “Tools” tool bar in ArcMap vs the “Layout” tools that manipulate the 
layout page. 

 

  



Add a Map Frame 
 

After the layout tab is created, a data frame must be added to the map.  This is the “window” where the 
map will be created on the “piece of paper.” 

Choose Insert—Map Frame—Default from the Insert Map Frame ribbon. 

 

Since the map zooms to the entire extent of the world, the map needs to focus on the City of 
Sacramento area. 

  



 

1. Expand the Map Frame by click on the little black triangle. 
2. Right click on the Council Districts and choose Zoom to Layer.  The map will center on the 

geographic extent of the Council District layer. 

 

 

 

 

 

Create Guides 



One useful item to add to a map layout is adding guides.  These show up at light blue lines on the map 
page to “snap” a map frame, graphics, legends, etc to specific areas on the map page. 

To create a guide do the following: 

1. Zoom into one of the corners of the layout (make sure the Layout tab is being used) 
2. Right click on the specific location in the ruler and choose Add Guide 

 

3. Do the same for each of the 4 corners (upper left, upper right, lower left, lower right) and any 
other locations that are desired. 

Snap Map Frame to Guide 
 

To snap the map frame to the guide, click on the Select tool in the Layout ribbon and click on the map 
fame.  Left click and drag a corner of the map frame to the corner of the intersecting page guides.  
Follow this same procedure for each corner of the map. 



 

 

Insert Map Elements 
 

Use the Insert ribbon to insert a legend, scale bar, graphics, text boxes. 

Inserted map elements show up on the left side of the layout page as “layers.”  The draw order of the 
map features can be changed by left clicking and dragging the selected map element to the new draw 
order location. 

Add a Graphic 
 

To add a graphic, click on one of the graphic options in the Insert ribbon.  For example, to add a 
rectangle to the map, choose the rectangle, then drag a box to create a rectangle. 



 

In the illustration above, an empty rectangle shape was added to the bottom of the map layout just 
beneath the map frame.  Notice that the rectangle is added above the map frame on the left side under 
the Drawing Order option in the Contents pane.  The drawing order is where the drawing order options 
are modified. 

The Format tab at the top of the ribbon allows the user to make changes to the graphic (such as color, 
line width.  Some options can be manipulated on the Symbol option on the Element pane on the right 
side. 



  

 

Add and Configure a Legend 

 

Print or Export a Map 
 

Click on the View, then Print to print the map layout or Export to save the map layout to a PDF. 

Catalog 
 

When a Pro project is created, a Catalog tab is present.  The Catalog pane is where a user can view data 
connections connected to a specific project, access data online (i.e. ArcGIS Online or Portal or other web 
service locations), through enterprise geodatabase connections, and/or network or local folder 
structures. 



 

 

Connect a Folder 
 

A common practice when using Pro is to connect to one or more network (preferably) folders.  To do 
this do the following. 

This example uses a folder called Sacramento_Data which contains a number of data layers. 

1. Right click on Folder, choose Add Folder Connection. 



 

As a second alternative to add a folder, click Insert—Add Folder 

 

As a third alternative, open Windows Explorer, browse to a folder, and drag it to the Content tab. 

 



 

2. Navigate to the folder location where the Sacramento_Data folder exists. 

 

3. Click one time on Sacramento_Data 
4. Click OK 

The C:\Sacramento_Data folder connection now appears in the Catalog tab 

 

 

Click here to 
Show/Hide the Details 
Panel to see more 
details about data sets 



Explore Folder Contents 
 

Catalog for Pro functions differently than in ArcCatalog.  The Pro Catalog shows the contents in a folder 
or database.  To see the “Preview” of the data, the Show/Hide Details pane in the upper right corner of 
the Catalog pane must be expanded. 

Change Metadata Options 
 

Another significant change between Pro and ArcCatalog is the ability to view and interact with the 
attribute table and other data properties (metadata), such as source, description, field definitions, etc.  
To get the most out of Pro, it is good practice to change the Metadata Options for a given project. 

To do this, click on the Project ribbon item. 

 

Click on Options—Metadata.  The default is Item Description, which provides minimal data details.  
Choose FGDC which provides more details (provided they exist).  In addition to source and coordinate 
system, field definitions do appear, which can be helpful when exploring data within Catalog. 

 



NOTE:  To really get a good feel for the data table characteristics, add the specific layer to an existing 
Map by right clicking on the data set and then choose Add to Map (or use Add to New Map, one a map 
does not already exist). 

 

 

To further explore the data in the Catalog pane, double click on the Sacramento_Data folder to expand 
the contents of the folder. 

The folder shows a number of different data types (a file geodatabase, layer files, an ArcMap document, 
and a raster image). 



 

Left double click on the Sacramento_Data.gdb to expand the contents of the file geodatabase.  A file 
geodatabase is a common ESRI data structure to store different kinds of data including feature classes 
(point, line, and polygon), raster images (non-file based), TIN, LAS Datasets, and stand alone tables, 
among others).  The different icons indicate the type of feature class, image, TIN, LAS, etc. 



 

 

For feature classes, left-clicking on the data set will show data properties.  At this time, the properties 
are a little different than those in ArcCatalog for Desktop.  For example, the data fields do not appear. 

 

Show/Hide Details 
 

Click on the icon in the upper right of the Contents pane (see above).   



Metadata 
 

The Metadata option shows many data details (provided they exist).  Field definitions and field types 
can be viewed. 

NOTE:  To Add New Fields to the existing data table, right click on the data layer and click Design.  The 
general data structure will appear, and new fields can be added.  Be careful, since new fields or changes 
to existing fields may cause irreparable problems in Projects, models, or scripts. 

 

            

 

Preview 
 

Preview shows an interactive overview in the Show/Hide Details pane.  The user can pan and zoom in 
within the window, but no Identify activity exists.  Add the data layer to a map to provide a full 
interactive experience with the data layer. 



 

View Data Fields 
 

To view data fields for a given data layer, right click on the data layer name in the Catalog pane and then 
click Design—Fields.   



 

The existing field definitions appear.  An option is provided to add new fields. 

NOTE:  To Add New Fields to the existing data table, right click on the data layer and click Design.  The 
general data structure will appear, and new fields can be added.  Be careful, since new fields or changes 
to existing fields may cause irreparable problems in Projects, models, or scripts. 

 



 

Explore the Data Layer in a Map 
 

To more fully experience all of the details about the data (e.g. total number of records, view the full 
attribute table, perform queries, data sorting by columns, etc), add the data layer to a map. 

    

 



Alternatively, if the Catalog pane is shown on the right, and the Map pane is active, then the user can 
drag and drop the data layer into the map. 

    

 

  



Finding and Using Web-based GIS Data 
 

Using data from web-based GIS services are becoming more common, especially with many 
organizations adopting the ESRI Open Data platform.  Organizations that use this platform essentially 
make their data available on the ESRI cloud and users of GIS software (ArcGIS Desktop, ArcGIS Pro, or 
other GIS software) can search and use data directly from the ESRI cloud.  NOTE:   

A user does not need to have an ArcGIS Online user name to search, find, and use data that is “open” on 
the ESRI cloud (aka the organizational Open Data platform). 

Search for Data Online 
 

1. Open up Pro and use an existing Pro file or create a new Pro project. 
2. Click on the Catalog tab 
3. Click on the All Portals option under Portals 
4. Type in key words to “search” for prospective data sets.  After hitting enter, a list of layers 

appears on the left side of the catalog pane. 

 

Exploring Data 
 

Most of the data exploration (map features or attributes) occurs in the Map pane. 

The “Identify” tool does not exist in Pro.  The user simply “clicks” on a feature to display a pop up 
window of the data attributes. 

The Map ribbon contains several options to explore data. 

Explore – similar to Identify in ArcGIS Desktop.  Options can be changed to “identify” the top most layer, 
selectable layers, visible layers, etc. 

Select – use this tool to highlight (aka select) features 

Select By Attribute – perform attribute selections 

Select By Location – perform data selections based on spatial coincidence or proximity 



 

Exploring the Data Attribute Table 
 

Once a data layer is in the Map, right click on the data layer in the Contents pane and choose Attribute 
Table. 



          

Alternatively, click on the Data ribbon and then click Attribute Table. 

 



The data table “docks” at the bottom of the map.  To “undock” the table, click on the table name and 
drag it slightly up from the bottom.  Expand the attribute table to view more columns and data. 

 

 

Attribute Selections (aka queries) are performed by using the Select By Attribute option in the Table 
View ribbon when the attribute table is displayed.  

 



If the attribute table is not displayed, Select By Attribute is performed through the Map ribbon. 

 

Select Data By Attribute 
 

To perform an attribute selection, choose Select By Attribute (from the Map ribbon, if the attribute 
table is not visible) or from the Data ribbon, if the attribute table is visible). 

On the right side of Pro, the Geoprocessing pane is activated and the Select Layer by Attribute 
geoprocessing tool is loaded.  The tool “parameters” (i.e. the different fields in the tool) are filled in and 
then the Run button is clicked to execute (run) the tool. 

Attribute queries are performed by choosing a data layer and creating a “query” statement using one or 
more fields and a number of different operators. 

1. Add the Schools layer (shown above from ArcGIS Online) or from the Sacramento_Data.gdb 
(file geodatabase) by using the methods describe above. 

2. Choose the Select By Attribute tool (the method illustrated here is using the Select By Attribute 
tool from the Map ribbon). 

3. In the Select Layer by Attribute geoprocessing tool, fill in the following parameters. 
a. Layer – schools 
b. Selection Type – New 



c. Expression  - use this syntax to select public schools.  Click the Add Clause button to 
start creating the query syntax.  Set the different data entry boxes to create the 
following syntax.  Click the Add button when completed. 
 

SCHOOL_TYPE is Equal To Public 
 

 

d. Check the “green check mark” to make sure the syntax is correct.  If it is not, then redo 
creating the query expression. 

e. Click the Run button to execute the query. 

The results should show the following “highlighted” (selected) “Public” schools from the schools layer. 



 

Notice 208 schools are “selected” in the lower right of the Map pane. 

To view the “selected” school attributes, expand Schools to show the schools layer with the different 
symbols, then right click on the schools layer and choose Attribute Table. 

The attribute table appears.  Use the vertical scroll bar to scroll down the different school attributes.  
The “selected” schools will show as highlighted. 



 

To “Clear” the selection, click on the Clear option in the Map ribbon. 

 

Select Data By Location 
 

Another way to explore data is to select data based on spatial coincidence or proximity.  For example, a 
“spatial query” can be performed to find all schools within the city limit of Sacramento.  “Within” 
defines a spatial relationship between the geographic extent of the schools layer and a cities layer. 

Make sure to “clear” the schools if the steps above were followed. 

1. With the Map pane visible, on the right side of Pro, click on the Catalog pane 
2. Browse and expand the Sacramento_Data.gdb file geodatabase 
3.  Left click and drag the citybndy layer to the Map pane.  Add the schools layer if it is not already 

added to the map.  Schools can be found in the same geodatabase or by adding the Sacramento 
Schools from ArcGIS online from the steps above. 

The map should look similar to the following.  The City boundary has been styled to show the base map 
for more clarity in this example. 

 



 

To perform a selection by location (i.e. spatial selection), click on the Select By Location option in the 
Map ribbon.  The geoprocessing tool appears on the right side. 

Fill in the following tool parameters. 

1. Input Feature Layer – schools 
2. Relationship – Intersect (this is the default and is similar to within or completely within) 
3. Selecting Features – citybndy 
4. Search Distance – leave empty for this example, but a “radius” outside of the city boundary 

could also be applied 
5. Selection Type – New 
6. Click Run 

 



 

Notice 168 schools “Intersect” (fall completely within) the city limit. 

The attribute table can be viewed in a similar manner as above by right clicking on the schools layer 
(may need to expand the layer in the Contents pane) and then choosing Attribute Table. 

 

  



Upload (Share Web Layer) Feature Class to ArcGIS Online 
 

Publishing a feature class from within Pro works a little different from ArcGIS Desktop.  Since ArcGIS Pro 
requires an ArcGIS Online account to actually use the software, the user typically will already have a 
connection to an organizational ArcGIS Online account. 

If a feature class is listed in the Table of Contents (Contents) section of the Map tab in Pro, the user can 
simply right-click on the feature class and choose Sharing--Share Web Layer. 

 

1. Open ArcGIS Pro 
2. Activate Pro with your ArcGIS Online account 
3. Choose the Map.aptx template (or choose an existing Pro project file) 
4. Add Data to the map.  You may have to create a connection to a folder or geodatabase 
5. Right click on the layer of interest, choose Share as Web Layer 
6. Fill in Summary and Tags.  These must be filled in to continue. 

 

 

7. Click Analyze.  If no errors occur, then click Publish.  This may take a minute or two, depending 
on the feature class size, number of features, and geographic extent.  If errors occur, review the 
messages and make the required changes. 

8. Login to ArcGIS Online and click on Content to see the uploaded feature service 



 

 

  



Appendices 
 
Cloning Python Environment 
 

Using Python for Pro may involve “cloning” the Python environment so that other Python libraries can 
be used.  Users cannot modify the default Python set of libraries, so the Python environment needs to 
be cloned.  This section discusses the methods used to create a “cloned” environment. 

This section also describes how to install the Spyder Interactive Development Environment (IDE) so that 
users can use a different scripting environment from the default IDLE (Python IDE) that has been the 
standard since Python has been used with ArcGIS (and is a default IDE for Python coders). 

NOTE:  Spyder is NOT required to write and test Python script.  Spyder is one of many alterative IDEs 
available (and is free).  Similar processes can be used to “install” all kinds of Python add-ons for various 
functionality (e.g. the author creates a second Python clone to install and use the Deep Learning image 
processing tools (i.e. through Deep Learning geoprocessing tools within Pro)). 

Overview 
 

Starting with ArcGIS Pro, the Python environment uses the 3.6 version of Python.  Python 3.x uses 
slightly different syntax than 2.x Python versions used in Desktop.  At this time (2018) Python 2.7.x and 
Desktop will be supported through 2023.  If all Python programming needs can be met with Desktop, 
then developers can continue to use Python 2.7.x and Desktop.  If there is a need for using ArcGIS Pro 
(for example, Desktop is not installed) or developers want to take advantage of ArcGIS Pro (e.g. 
automating custom map creation using the mapping environment found in Pro (i.e. that uses the 
Project—multiple map layout concepts), then Python 3.x will be required). 

Interactive Development Environments (IDEs) vary in functionality, too.  IDLE (is the default IDE 
installed with Python).  This is often sufficient to write code but doesn’t offer any easy way to perform 
code completion or hints).   

The Spyder IDE has become a good alternative to the default IDLE IDE.  To use Spyder with ArcGIS Pro, 
the Python environment must be “cloned” (i.e. have a copy made), then install Spyder from within Pro. 

NOTE:  Remember, if Spyder will be used, then all code must follow Python 3.x coding requirements.  
For example, the print routine acts as a “function” in Python 3.x and uses a different syntax than in 2.x. 

 

Clone the Current Python arcgispro-py3 Environment 
 

1. Click on Python in the main section of ArcGIS Pro. 
2. Click Manage Environments 



 

 



3. Click Clone.  This will take several minutes. 

 

 



 

 

4. Click the “Cloned” Python environment as the “default.” 



 

 

5. Close Pro (Exit), then reopen it. 

 

Install Spyder IDE 
 

1. Go to Settings—Python and click Add Packages. 
2. Type in spyder.  

 

3. Click Install. This will install Spyder.  This will take a few minutes. 

The cloned version will become the 
“default” version when the “clone” is 
checked in the Managed Environments 
section of the ArcPro Python section. 



 

NOTE:  The Spyder version appears for the supported version in Pro.  The screen shot below is for Pro 
2.6 (as of 8/24/2020).  Spyder 3.3.6 will be installed.  There is no need to install the Spyder-kernel 
package.  A version of this package is installed during the Spyder package install. 

 

 

After installing Spyder, 

1. Click on Installed Packages 
2. Click the refresh button (to refresh all of the packages installed) 
3. Scroll down the list of installed packages.  Notice the Spyder package is now installed. 

 



 

 

Start Spyder IDE 
 

1. Start Python Command Prompt. 
a. Option 1 – Programs list—ArcGIS—Python Command Prompt 
b. Option 2 – Type in Python Command Prompt in the Search window of Windows 10 or 

Windows 7 (usually, lower left of the computer screen) 
2. Type in spyder when the Python prompt appears 

 



     
 

3. Click Enter.  The Spyder IDE will launch. 

A message may appear that a Spyder update is available.  Click OK to close the window.  No update will 
occur.  There is no need to update Spyder.   

NOTE:  The instructor experienced several problems when attempting to “update” Spyder.  DO NOT 
UPDATE to any “prompted” Spyder version.  You will likely need to remove the clone, redo the clone, 
and reinstall the Spyder IDE. 

 

Spyder will look like this. 



 

 

Using IDLE with a Python Clone 
 

Similar to launching Spyder, launch the Python Command Prompt and type in idle. 

 

The IDLE “shell” will appear. 

Code is written here. 

Code results show here.  For 
example, print statements. 

Click the Run button (green 
triangle) to “run” a script. 



 

To start writing an actual Python script, 

1. Go to File—New.  A new script window appears 



 

2. Make sure to save the script file somewhere on disk and make sure to use the .PY extension, 
otherwise, the file will be saved as plain text (and not show the color coding and you cannot 
“run” a Python file without it being named with the .PY extension). 

  



Updating Pro and Python Clones 
 

When updating Pro from one major version to another (e.g. 2.4 to 2.5), the Python clone will likely need 
to be removed and then reclone the Default Python environment.  Updates within a specific version 
(e.g. 2.5.1, 2.5.2, etc) likely do not need to have the Python clone updated. 

 

1. Update ArcGIS Pro by using the Update link within the About section of ArcGIS Pro. 
2. Check the Python clone in the Python section of Pro (Settings—Python). 
3. CIick on the Manage Environments.  If a red X appears, this indicates the Python clone is 

“broken.” 
4. Remove the existing clone. NOTE:  This takes approximately 10 minutes.  If the gauge keeps 

recycling after 10 minutes or so, click the upper right X to close the window. 
5. Click on the Manage Environments button again, the click Clone Default.  This will take 5-10 

minutes. 

 

After the clone was created 



 

After the install is complete.  Open up Python--Mange Environments and choose the “cloned” 
environment. 

 

 

6. You will be prompted to restart Pro 
7. Start the Python Command Prompt window 
8. Type in idle (to start the IDLE IDE environment) 



 

Updating the Spyder IDE using the New Clone 
 

Installing the Spyder IDE after recreating the Python clone follows the same steps as above.  Installing 
the Spyder IDE is not required to write and run Python scripts for Pro.  Spyder is an option for creating 
and running Python scripts like the default IDLE IDE. 

Make sure the “clone” environment is the “default” Python environment. 

 

 

1. Click Add Packages 
2. In the Search box, type Spyder 
3. Click Install.  This will take approximately 5 minutes 
4. After completing, Click on the Installed Packages button 
5. Click the refresh icon (the two arrows) and scroll down the list to see that Spyder was installed. 
6. Start the Python Command Prompt window 
7. At the command prompt, type spyder 

 

 


